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Conventions

These style and syntax conventions are used in Sybase® documentation.

Style conventions

Key Definition

monospaced(fixed-
width)

• SQL and program code

• Commands to be entered exactly as shown

• File names

• Directory names

italic monospaced In SQL or program code snippets, placeholders for user-specified
values (see example below).

italic • File and variable names

• Cross-references to other topics or documents

• In text, placeholders for user-specified values (see example be-
low)

• Glossary terms in text

bold san serif • Command, function, stored procedure, utility, class, and meth-
od names

• Glossary entries (in the Glossary)

• Menu option paths

• In numbered task or procedure steps, user-interface (UI) ele-
ments that you click, such as buttons, check boxes, icons, and so
on

If necessary, an explanation for a placeholder (system- or setup-specific values) follows in
text. For example:

Run:
installation directory\start.bat

where installation directory is where the application is installed.

Conventions
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Syntax conventions

Key Definition

{ } Curly braces indicate that you must choose at least one of the enclosed options. Do
not type the braces when you enter the command.

[ ] Brackets mean that choosing one or more of the enclosed options is optional. Do
not type the brackets when you enter the command.

( ) Parentheses are to be typed as part of the command.

| The vertical bar means you can select only one of the options shown.

, The comma means you can choose as many of the options shown as you like,
separating your choices with commas that you type as part of the command.

... An ellipsis (three dots) means you may repeat the last unit as many times as you
need. Do not include ellipses in the command.

Case-sensitivity

• All command syntax and command examples are shown in lowercase. However,
replication command names are not case-sensitive. For example, RA_CONFIG,
Ra_Config, and ra_config are equivalent.

• Names of configuration parameters are case-sensitive. For example, Scan_Sleep_Max is
not the same as scan_sleep_max, and the former would be interpreted as an invalid
parameter name.

• Database object names are not case-sensitive in replication commands. However, to use a
mixed-case object name in a replication command (to match a mixed-case object name in
the primary database), delimit the object name with quote characters. For example:
pdb_get_tables "TableName"

• Identifiers and character data may be case-sensitive, depending on the sort order that is in
effect.
• If you are using a case-sensitive sort order, such as “binary,” you must enter identifiers

and character data with the correct combination of uppercase and lowercase letters.
• If you are using a sort order that is not case-sensitive, such as “nocase,” you can enter

identifiers and character data with any combination of uppercase or lowercase letters.

Terminology
Replication Agent™ is a generic term used to describe the Replication Agents for Adaptive
Server® Enterprise, Oracle, IBM DB2 UDB, and Microsoft SQL Server. The specific names
are:

• RepAgent – Replication Agent thread for Adaptive Server Enterprise
• Replication Agent for Oracle

Conventions
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• Replication Agent for Microsoft SQL Server
• Replication Agent for UDB – for IBM DB2 on Linux, Unix, and Windows

Conventions
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Introduction

Getting Started with Replication Server® is for users of Adaptive Server Enterprise who are
new to Replication Server. Use the step-by-step instructions to install, configure, and set up a
sample Replication Server and a simple replication environment for replicating data from one
Adaptive Server database to another. Getting Started with Replication Server describes only
those tasks necessary to set up a simple replication system.

Replication Environment Components
Become familiar with the various components of a replication environment.

In addition to Replication Server, the replication environment includes:

• A primary database, which is the source of data for replication, and a replicate database, to
which you replicate data.
To set up a test environment, either install identical copies of the pubs2 or pubs3
databases that come with Adaptive Server, or create copies of your own.

• Two Adaptive Server Enterprise data servers. The primary Adaptive Server manages the
primary database and the replicate Adaptive Server manages the replicate database.

• Sybase Central™, the Sybase graphics-based management tool, and Replication Manager,
the Replication Server plug-in to Sybase Central, Java Edition.

Note: Sybase Central and the Replication Manager plug-in are available on a separate
installer.

• The Embedded Replication Server System Database (ERSSD), which stores information
about the replication environment.

• Replication Monitoring Services (RMS), which is a middle monitoring layer that provides
monitoring services to replication environments.

Preinstallation Tasks
You need to perform some preinstallation tasks before installing Replication Server.

See the Replication Server Release Bulletin for your platform for the updated list of operating
systems and platforms that Replication Server supports and for the latest operating system
patches, as well as for any last-minute information that was too late to be included in the
document.

The preinstallation tasks include:

Introduction
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1. Planning your replication system – identify the primary and replicate Adaptive Servers
and the primary and replicate databases.

2. Obtaining a license – Sybase products, such as Replication Server, require valid license
keys to use the product beyond a grace period.

3. Checking system requirements – verify that you are running a supported operating system
and that you have sufficient space available to set up and run Replication Server.

4. Selecting an installation directory for Replication Server – it is important that you select an
installation directory that is compatible with your existing Sybase software. This may
involve installing Replication Server in an existing Sybase installation directory or in a
completely new installation directory.

5. Creating the Sybase user account, if one does not already exist.
6. Verifying your environment – verify that you have the proper user accounts and privileges.

Planning Your Replication System
Identify the primary Adaptive Server and the replicate Adaptive Server. The primary Adaptive
Server manages the primary database and the replicate Adaptive Server manages the replicate
database.

1. To set up a test environment, install identical copies of either the pubs2 or pubs3
database.

2. Verify that both Adaptive Servers are up and running before you configure Replication
Server.

Obtaining a License
Obtain valid SySAM licenses before you begin the installation. Sybase Software Asset
Management (SySAM) performs license administration and asset management tasks for
Sybase products.

Before installing your product, obtain license files from the Sybase Product Download Center
(SPDC) at https://sybase.subscribenet.com using SPDC access information you receive from
Sybase or your Sybase reseller.

Log in to SPDC by using the information in your SPDC welcome e-mail message.

Note: If you purchased your Sybase software from a Sybase reseller, you receive a Web key
rather than an e-mail message.

See Replication Server Installation Guide > Planning Your Installation > Obtaining a License
to learn more about Replication Server product editions, and licensing options such sub-
capacity licensing. For detailed instructions to configure SySAM licensing, see the Sybase
Software Asset Management Users Guide on the Sybase Product Documentation Web site at
http://sybooks.sybase.com.
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System Requirements
Check the system requirements and system patches for the server on which you will install
Replication Server.

System Requirements for Replication Server on Windows Platforms
Verify that you are running a supported operating system and that you have sufficient space
available to set up and run the sample Replication Server on Windows.

Item Requirement

CPU A Pentium processor.

RAM A minimum of 512MB RAM.

Disk storage For a full installation, the total disk space required is approximately 750MB.

Disk space required:

• 450MB for the Replication Server software, supporting files, and log
files.

• 300MB if you are installing DA Option.

• 20MB for each Replication Server disk partition. The disk partition may
be on a different disk than your Sybase software.

• 30MB for temporary usage during installation.

One of:

• Disk space for your Adaptive Server Enterprise database, which serves
as your Replication Server System Database (RSSD) if you are not using
the Embedded RSSD (ERSSD). See your Adaptive Server Enterprise
documentation for system requirements.

• 80MB for your SQL Anywhere
®
 database, which serves as your ERSSD.

The database directory, transaction log directory, and backup directory
that make up the 80MB should each reside on different disks.

More disk space may be required, depending on your replication system
application.

Introduction
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Item Requirement

Operating system One of:

• Windows XP Professional, Service Pack 2 or later

• Windows Server 2008 R2

• Windows 7

If you are installing Replication Server on Windows 64-bit, download and
install the latest security updates from the Microsoft Web site.

Before you start the installation, install the relevant Microsoft Visual Studio
2005 patch for your x86 or x64 Windows platform.

Download Microsoft Visual C++ 2005 Service Pack 1 Redistributable Pack-
age ATL Security Update at http://www.microsoft.com/download/en/de-
tails.aspx?amp;displaylang=en&id=26347.

Additional hardware A minimum of 32-bit network card for better performance.

Supported protocols TCP/IP, IPX/SPX, Microsoft Named Pipes.

System Requirements for Replication Server on UNIX
Verify that you are running a supported operating system and that you have sufficient space
available to set up and run the sample Replication Server on UNIX platforms.

Item Requirement

RAM A minimum of 512MB RAM.

Introduction
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Item Requirement

Disk storage For a full installation, the total disk space required is approximately 2GB.

Disk space required:

• 950MB for the Replication Server software, supporting files, and log files.

• 350MB if you are installing Data Assurance (DA) Option.

• An additional 20MB for each Replication Server disk partition. The disk
partition may be on a different disk than your Sybase software.

One of:

• Disk space for your Adaptive Server Enterprise database, which serves as
your Replication Server System Database (RSSD) if you are not using the
Embedded RSSD (ERSSD). See your Adaptive Server Enterprise docu-
mentation for system requirements.

• 80MB for your SQL Anywhere database, which serves as your ERSSD.
The database directory, transaction log directory, and backup directory that
make up the 80MB should each reside on different disks.

More disk space may be required, depending on your replication system ap-
plication.

Introduction
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Item Requirement

Operating system One of:

• HP-UX Itanium 11.31 (64-bit)

The installer requires the gzip utility. Ensure that the path to gzip is set in
the $PATH environment variable.

• IBM AIX (64-bit):

• AIX 6.1

• AIX 7.x

Before you install Replication Server, install the IBM XL C/C++ Runtime
for AIX and the SMP Runtime Libraries required for your version of AIX.
Obtain the libraries from your IBM AIX operating system installation
media.

These libraries are also available from the IBM AIX Web site:

• The IBM XL C/C++ Runtime for AIX is available on the Web site
under “Latest updates for supported IBM C and C++ compilers.”

• The SMP Runtime Libraries for AIX are available on the Web site
under “IBM XL C/C++ Enterprise Edition for AIX, Runtime Envi-
ronment and Utilities.”

To verify that the libraries are installed, issue:

source $SYBASE/SYBASE.csh
cd $SYBASE/$SYBASE_REP/bin
ldd ./repserver

• Linux x86-64 (64-bit):

• Red Hat Enterprise Linux 5.5

• kernel - 2.6.18-194.el5 SMP

• glibc - 2.5-49

• Red Hat Enterprise Linux 6.0

• kernel - 2.6.32-71.el6.x86_64 SMP

• glibc - 2.12-1.7.el6.x86_64

• glibc - 2.12-1.7.el6.i686

• SuSE Linux Enterprise Server SLES 10, Service Pack 2

• kernel - 2.6.16.60-0.21 SMP

• glibc - 2.4-31.54

• SuSE Linux Enterprise Server SLES 11

• kernel - 2.6.27.19-5.1

• glibc - 2.9-13.2

• SuSE Linux Enterprise Server SLES 11, Service Pack 1

• kernel - 2.6.32.12-0.7

• glibc - 2.11.1-0.17.4
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Item Requirement

• Linux on IBM p-Series (Linux on POWER) (64-bit):

• Red Hat Enterprise Linux 5.5

• kernel- 2.6.18-194.el5 SMP

• glibc-2.5-49

• Red Hat Enterprise Linux 6.0

• kernel- 2.6.32-71.el6.ppc64 SMP

• glibc-2.12-1.7.el6.ppc64

• glibc-2.12-1.7.el6.ppc

• SuSE Linux Enterprise Server SLES 10, Service Pack 2

• kernel-2.6.16.60-0.21-ppc64 SMP

• glibc-2.4-31.54

• SuSE Linux Enterprise Server SLES 11, Service Pack 1

• kernel-2.6.32.12-0.7-ppc64 SMP

• glibc-2.11.1-0.17.4

Before you install Replication Server, install the runtime libraries for
the IBM XL C compiler. To verify that IBM XL C runtime packages are
installed, issue:

vacpp.rte-10.1.0-0

If the message is “package vacpp.rte-10.1.0-0 is
not installed”, download the IBM XL C version 10.1 runtime

executables from the IBM Web site at https:// www-304.ibm.com/sup-
port/docview.wss?uid=swg24021253. Make sure that you select the
appropriate installation package for your operating systems from the
download table.

• Solaris (64-bit)

• Solaris SPARC 10

• Solaris 10 x64

Supported proto-
cols

TCP/IP

Installation Directory for Replication Server
You must choose carefully whether to install Replication Server in its own product directory or
in a directory with other Sybase products.

In some cases, installing Replication Server on top of existing Sybase applications can
adversely and irreversibly affect those applications.
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Replication Server Installation in an Existing Directory
There are several restrictions to the directories where you can install Replication Server.

Do not install Replication Server 15.7.1 in an existing Sybase installation directory if that
directory contains these Sybase products:

• Replication Server version 12.5 or earlier
• Adaptive Server version 12.5.0.x or earlier
• Open Client/Server™ version 12.5.0 or earlier
• OpenSwitch™ version 12.5 or earlier
• DirectConnect™ version 12.5 or earlier

Warning! Installing Replication Server 15.7.1 on top of any of these products incapacitates
older versions of these products, and can also adversely affect other Sybase products; you
cannot reverse these effects by performing an uninstallation.

Replication Server Installation in a Unique Directory
On UNIX platforms, you can install Replication Server in a unique directory without affecting
existing Sybase environment variables. You might have to reset environment variables if you
installing Replication Server 15.7.1 in a unique directory on Windows platforms.

Note: When you install Replication Server in a unique installation directory, you must
maintain two interfaces files—one for Replication Server components and one for your other
Sybase applications.

See also
• Adding Server Entries to the Interfaces Files on page 20

• Installing Replication Server on page 15

Installing Replication Server in a Unique Directory on Windows
Installing Replication Server in a unique directory may reset environment variables for other
Sybase products and produce unpredictable results.

1. Terminate all Sybase processes running on the system on which you are installing
Replication Server, including the SySAM License Server if you plan to upgrade it.

Note: If you do not know which processes are running, contact your system administrator.

To stop the SySAM license server, see the SySAM Users Guide.

2. If you have an existing Adaptive Server that runs as a Windows service, disable the service.

a) Click Start > Settings > Control Panel > Administrative Tools >  Services.
b) In the Services list, right-click Sybase SQLServer  server name.
c) Select Properties.
d) Set Startup Type to Disabled.
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e) Close the Services window.

3. Record the current environment variable settings in a file called env.orig by
entering:

set > env.orig

You can read this file with a text editor.

Specifically, record the current values of:

• INCLUDE
• LIB
• LM_LICENSE_FILE
• PATH
• SYBASE
• SYBASE_JRE

4. Insert the Replication Server media in the appropriate drive, or download and extract the
Replication Server installation image from the Sybase Product Download Center (SPDC).

5. Install Replication Server.

6. Specify a unique directory for the Replication Server product.

7. Specify the host name and port number of the license server.

8. Change the environment variables to the original settings that you recorded in step 3:

a) Select Start > Settings > Control Panel > System.
b) Click the Advanced tab.
c) Select Environment Variables.
d) Under System Variables, change the values of the variables listed in step 3.

9. Configure Adaptive Server to start automatically:

a) Select Start > Settings > Control Panel > Administrative Tools > Services.
b) In the Services list, right-click the Sybase SQLServer server name.
c) Click Properties.
d) Set Startup Type to Automatic.

10. Restart your system.

Note: When you install Replication Server in a unique installation directory, you must
maintain two sql.ini files: one for Replication Server components and one for your
other Sybase applications.

Creating the Sybase User Account
Create a Sybase user account to ensure that Sybase product files and directories are created
with consistent ownership and privileges.

A user, such as the Sybase system administrator— who has read, write, and execute privileges
—must perform all installation and configuration tasks. For Windows, the user must have the
Administrator privilege.
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1. To create a Sybase system administrator account, choose an existing account, or create a
new account and assign a user ID, group ID, and password for it.

This account is sometimes called the “sybase” user account. See your operating system
documentation for instructions on creating a new user account.

If you have already installed other Sybase software, the “sybase” user already exists.

2. Verify that you can log in to the machine using this account.

Verifying Your Environment
Verify your environment before starting the installation process.

1. Free memory and system resources by closing any open applications or utilities, including
currently installed Sybase components.

2. Review the system requirements and verify that the directory location for the Sybase
installation has sufficient space.

3. Check your operating system documentation or consult your operating system
administrator.

4. Verify that your network software is configured.

Sybase software uses network software, even if Replication Server and Sybase client
applications are installed on a machine that is not connected to a network.

5. Check your platform-specific release bulletin for last-minute information about installing
and running Replication Server.

The latest release bulletins are also available on the Sybase Product Documentation Web
site at http://www.sybase.com/support/manuals.
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Replication Server Installation

The Replication Server installation program places all Replication Server software
components in the Sybase installation directory.

The installation program also sets the environment variables and default parameters needed
for sample Replication Server and starts sample Replication Server when the installation
process is complete.

Installing Replication Server
Install Replication Server components.

Prerequisites

• Review the system requirements and complete the preinstallation tasks.
• Verify that you are logged in as the “sybase” user with read, write, and execute privileges.

Task

See the Replication Server Installation Guide to uninstall Replication Server. For more
information, refer to your operating system documentation or consult your operating system
administrator.

1. Insert the Replication Server product CD or DVD in the appropriate drive.

2. Mount the CD or DVD.

On Windows:

The operating system automatically mounts the CD or DVD. Go to step 4.

On HP Itanium:

a) Log out.
b) Log in as “root.”
c) Enter the following command, where device_name is the name of the CD or DVD drive

device and /mnt/cdrom is the name of the directory where the CD or DVD is to be
mounted:
mount -F cdfs -o ro device_name /mnt/cdrom

d) Log out as “root”.
e) Log in as “sybase.”

On IBM AIX:

Enter the following or similar command, where device_name is the name of the CD or
DVD drive device and /mnt/cdrom is the name of the directory where the CD or DVD is to

Replication Server Installation
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be mounted. The mount command is site-specific, so your mount syntax may differ from
this example.

mount -v ‘cdrfs’ -r device_name /mnt/cdrom

On Linux:

Enter this command at the # prompt:

mount -t iso9660 /dev/cdrom /mnt/cdrom

On Solaris:

The operating system automatically mounts the CD or DVD. Go to step 4.

If you get CD or DVD reading errors, check your operating system kernel to make sure that
the ISO 9660 option is turned on.

If your CD or DVD shows up as anything other than sybasecd on your machine (for
example, sybasecd#1), this means you have previously installed a Sybase CD or DVD
on your system.

To install this CD or DVD, restart your system or delete the sybasecd file in /vol/
dsk.

3. Invoke the installer to install Replication Server in GUI mode.

On Windows:

Windows automatically finds and opens the setup file. Go to step 5.

If the installer does not open, double-click setup.exe or select Start > Run and enter the
following command, where x is the CD or DVD drive and -i swing specifies the GUI
installation mode:

x:\setup.exe -i swing

On all UNIX platforms:

Set the DISPLAY environment variable to point to a host with a graphical user interface
such as X-Windows, otherwise, the installation starts in console mode.

On HP Itanium:

Enter the following command, where cdrom is the directory you specified when mounting
the CD or DVD:

cd /cdrom
./setup.bin -i swing

On IBM AIX:

Enter the following command, where device_name is the name of the CD or DVD drive
device:

Replication Server Installation
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cd /device_name
./setup.bin -i swing

On Linux:

Enter the following command at the # prompt:

cd /mnt/cdrom
./setup.bin -i swing

On Solaris:

Enter the following command, where cdrom is the directory you specified when mounting
the CD or DVD and volume label is the volume name in the /cdrom directory:

cd /cdrom/volume label
./setup.bin -i swing

4. Go to step 5 unless you see a message warning that there is not enough disk space in the
temporary disk space directory. Set the temporary directory to a directory with at least
1GB of disk space on UNIX and 300MB on Windows. To set the temporary directory on:

• Windows – set the TMP environment variable to the temporary directory.
• UNIX and Linux – set the IATEMPDIR environment variable to the temporary

directory.

5. Shut down other programs and click Next.

6. In the Choose Install Folder window, do one of:

• Accept the default installation directory and click Next.
The UNIX default install directory is /opt/sybase and the Windows default
directory is C:\Sybase.

• Enter a different installation directory name, and then click Next.
You cannot enter spaces or double-byte characters in the directory name.
The installer warns you if you choose to install in an existing Sybase product directory.
In some cases, installing Replication Server in an existing directory can irreversibly
affect other Sybase software.

7. In the Choose Install Set window, select Typical installation and click Next.

Note: A typical installation installs the Replication Server components considered to be
useful for most customers.

8. Select your geographic location.

9. Read the Sybase license agreement. If you agree to the terms of the Sybase license, select I
agree to the terms of the Sybase license for the install location specified. Click
Next.

You must agree to the license agreement to proceed with the installation.

10. If the installer does not detect any license it can use, you see the SySAM window. Select
one of:

Replication Server Installation
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• Specify License Keys – click Browse to select the license file or copy the license key
directly into the pane, and then click Next. If you specify a served license key, the
installer prompts you to install a new SySAM license server. Select:
• Next – to install the new SySAM license server and follow the installation prompts.
• Previous – and select Use previously deployed license server if you have an

existing SySAM license server on the same host.
• Use Previously Deployed License Server – if you have a SySAM license server

already installed, then enter the host name and the port number of the license server.
Click Next.

• Continue Installation Without a License Key – if you do not have licenses for any of
the Replication Server components. Click Next to proceed. You can install and use
Replication Server components without a license for a grace period of 30 days. Click
Next.

Note: Your grace period starts when you install the product.

See the SySAM Users Guide.

11. Enter the information required in the SySAM Notification window and click Next.

12. The Pre-Installation Summary window displays the selections you have made. Review the
information , and click Install. The installer installs the components on your hard drive
and displays the progress of the installation.

13. Select Yes to start the sample Replication Server. Click Next.
The installer prompts to enter the password for the SAMPLE_RS.

Enter a password for the sample Replication Server:

You can enter a maximum of 30 bytes in the password field. For:
• single-byte character – enter 6 to 30 characters.
• double-byte character – enter 3 to 15 characters.

After you enter a valid password, the installer displays the configuration information
related to the sample Replication Server.

14. Click Next.
You see a message confirming a successful installation.

15. Click Done to close the installer.

You are now ready to create the replication environment.

Next
Perform the necessary postinstallation tasks before setting up your replication environment.

See also
• The Replication Environment on page 23
• Installation Directory for Replication Server on page 11
• Replication Server Installation in a Unique Directory on page 12
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Postinstallation Tasks
After installing Replication Server, perform the postinstallation tasks necessary for your site.

Adding a Login for Replication Manager to the Adaptive Servers
Add a login name and password for Replication Manager to the primary database and to the
replicate database. Grant each login name "sso_role" and "sa_role". The Replication Manager
plug-in to Sybase Central uses these names to log in to the data servers.

Create the login names and passwords and grant the required privileges using the Adaptive
Server plug-in to Sybase Central, Java Edition.

Alternatively, use the sp_addlogin system procedure and grant command at the command
line.

For more information, see Adaptive Server Enterprise System Administration Guide: Volume
1 > Managing Adaptive Server Logins, Users, and Client Connections.

Changing the Replication Server Host Name Using dsedit
Modify the default host name "localhost" in the Replication Server interfaces file to the actual
server name if either the primary or the replicate Adaptive Server is not on the Replication
Server machine.

1. Shut down the sample Replication Server by executing shutdown at the isql prompt in
%SYBASE%\REP-15_5\samp_repserver on Windows or $SYBASE/
REP-15_5/samp_repserver on UNIX.

2. Navigate to %SYBASE%\OCS-15_0\bin (Windows), or $SYBASE/OCS-15_0/
bin (UNIX).

3. On Windows, double-click dsedit.exe.

On UNIX, enter:

dsedit

4. Select InterfacesDriver and click OK.

5. In the left pane, select SAMPLE_RS.

6. In the right pane, double-click Server Address, then click Edit.

7. In the Network Address field:

• Delete localhost.
• Add the name of the machine on which Replication Server will run.

8. Click OK twice, then select File > Exit.

9. Restart the sample Replication Server.

On Windows, either:
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• Select Control Panel > Administrative Tools > Services, right-click Sybase
Rep_SAMPLE-RS, and select Start.

• Double-click RUN_SAMPLE_RS.bat or execute RUN_SAMPLE_RS.bat on the
command line from %SYBASE%\REP-15_5\samp_repserver.

On UNIX and Linux – execute RS_SAMPLE_RS on the command line from $SYBASE/
REP-15_5/samp_repserver.

For more information on dsedit, see Adaptive Server Enterprise Utility Guide > Using
dsedit.

Server Entries to the Interfaces Files
When you install Replication Server in an existing Sybase installation directory, the installer
adds Replication Server information to the existing interfaces file. When you install
Replication Server in a unique installation directory, the installer creates a new interfaces file.
In this instance, you will have two interfaces files—one for your existing Sybase applications
and one for Replication Server.

To allow the Adaptive Servers and Replication Server to communicate, you must:

• Add an entry for Replication Server in the Sybase interfaces file used by the Adaptive
Servers

• Add entries for the primary and replicate Adaptive Servers in the Replication Server
interfaces file

For each server, you need:

• Server name
• Host name
• Port number

Adding Server Entries to the Interfaces Files
Use dsedit to add entries for the primary and replicate Adaptive Server in the Replication
Server interfaces file.

1. Navigate to %SYBASE%\OCS-15_0\bin (Windows), or $SYBASE/OCS-15_0/
bin (UNIX).

2. On Windows, double-click dsedit.exe.

On UNIX, enter:

dsedit

3. Select InterfacesDriver and click OK.

4. Select Server Object > Add.

5. Enter the name of the primary Adaptive Server. Click OK.

6. Enter the host name and port number of the primary Adaptive Server. For example:
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chaucer, 35356

7. Click OK.

8. Select Server Object > Add.

9. Enter the name of the replicate Adaptive Server. Click OK.

10. Enter the host name and port number of the replicate Adaptive Server. For example:
johnson, 9756

11. Click OK twice, then select File > Exit.
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The Replication Environment

Set up a replication environment and configure a sample Replication Server for replication.

To set up and configure Replication Server without using Replication Manager, see the
Replication Server Configuration Guide for your platform.

Starting Sybase Central
Start Sybase Central.

Perform any of these to start Sybase Central:
In Windows:

• Select Start > Programs >  Sybase  > Sybase Central v6.0.
• Create a shortcut on your desktop for Sybase Central.
• Navigate to %SYBASE%\Shared\Sybase Central 6.0.0\win32 on 32- bit

Windows platforms or the win64 subdirectory on 64-bit platforms.

• Double-click scjview.exe.

In UNIX:

• cd $SYBASE
source SYBASE.sh
./runSybaseCentral

• Execute:
source $SYBASE/SYBASE.sh
$SYBASE/Shared/sybasecentral600/scjview.sh

Note: To run Sybase Central on UNIX platforms, you must have a graphical user interface
(GUI), such as X-Windows.

The Sybase Central main window appears. The Replication Manager icon appears in the left
and right panes.

Defining the Replication Environment
Define the Replication Environment. A replication environment is an object in Replication
Manager that represents all servers that participate in replication.

Prerequisites
Verify that you have started the sample Replication Server.
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Task

Use the wizard to add the Replication Server, the primary Adaptive Server, and the replicate
Adaptive Server. Record the user names and passwords that you define, as you will need this
information later on.

This task uses the sample Replication Server named SAMPLE_RS created during installation.

1. From the left pane of the Sybase Central main window, select the Replication Manager
icon.

2. In the right pane, double-click Add Replication Environment.

3. Enter a name for your replication environment; for example MY_RSENV. Click Next.

4. Enter a user name, password, and retype the password in the confirmation field to access
the replication environment. Click Next.

5. Click Add. Select the type of server to add to the environment. To add the sample
Replication Server, select Replication Server. Click Next.

6. Select SAMPLE_RS as the server. Click Next.

7. Enter:

• User name – sa
• Password – sa user password for the SAMPLE_RS. You can enter a maximum of 30

bytes in the password field. For:
• single-byte character – enter 6 to 30 characters.
• double-byte character – enter 3 to 15 characters.

Click Next.

8. Click Next to move past the Select RSSD Server window.

9. Enter:

• User name – SAMPLE_RS_RSSD_prim
• Password – Same as the password for SAMPLE_RS.

Click Next.

10. Click Finish.

11. Click Add to add Adaptive Server Enterprise containing the primary database to the
environment. Select Adaptive Server Enterprise and click Next.

12. Select the primary Adaptive Server from the Servers list. Click Next.

Add a user name and password that Replication Manager can use to log in to the primary
database. This user must be the system administrator, or the equivalent, with "sso_role"
and "sa_role" privileges.
• User name
• Password

Click Finish.
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13. Click Add to add Adaptive Server Enterprise containing the replicate database to the
environment. Select Adaptive Server Enterprise and click Next.

14. Select the replicate Adaptive Server from the Servers list. Click Next.

Add a user name and password that Replication Manager can use to log in to the replicate
database. This user must be the system administrator, or the equivalent, with "sso_role"
and "sa_role" privileges.
• User name
• Password

Click Finish.

15. Click Next.

Check the summary page to make sure the information is correct and complete.

If the information is not correct, click Back to return to previous pages and correct the
information.

16. Click Finish.

In Sybase Central, the new replication environment icon using the name you specified appears
in the left pane beneath the Replication Manager icon.

Configuring Replication
Create connections between servers, a database replication definition, and a database
subscription.

Prerequisites
Verify that you have created the replication environment.

Task

The database replication definition describes the information that can be replicated from the
primary database. The database subscription describes the replicated information that the
replicate database can accept. In this instance, Replication Manager creates the database
replication definition and the database subscription for you. You are ready to replicate data
once you successfully complete this task.

1. In the left pane of the Sybase Central main window, select the replication environment
object you created.

2. In the right pane, double-click Configure Replication.

3. Select Create an Environment Where the Primary Database is Replicated to Several
Replicate Sites. Click Next.
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4. Select the primary Adaptive Server and the primary database. For example, select the
pubs2 or pubs3. Click Next.

5. Select SAMPLE_RS. Click Next.

6. Select the replicate Adaptive Server and the replicate database. Click Add.
Replication Manager creates a connection between the sample Replication Server and the
replicate data server and database. This connection, target_server.database, appears in the
Connections list. Click Next.

7. Accept the default maintenance user name and password. Replication Manager creates the
maintenance user. Click Next.

8. Accept the default RepAgent user name and password.
Replication Manager creates the RepAgent user. Click Next. Select a materialization
method.

9. Select Create Subscription Without Materialization.
This specifies that the primary and target databases are already synchronized. Click
Next.

10. Review the summary of the replication environment.

If everything looks correct, click Finish. If not, click Back to return and make the
necessary changes. Click Finish when you are satisfied that the summary environment
information is correct.

11. Review the summary to make sure each step was successful. Click Close.

You have installed a sample Replication Server, set up a replication environment, and
configured the environment for replication. You are ready to replicate information from the
primary to the replicate database in this sample environment.

Verifying Data Replication
Use Transact-SQL® commands to verify that replication is occuring.

Transact-SQL is used in Adaptive Server databases for querying, adding new data, modifying
existing data, and deleting existing data. Transact-SQL is described in the Adaptive Server
Enterprise Transact-SQL Users Guide.

1. Log in to the primary database and use Transact-SQL commands to add, alter, or delete
information in one or more of the primary database tables.

2. Log in to the replicate database and confirm that your changes have been replicated.

Example

This example shows how to perform a simple update in the primary database, and then view
the replicated changes in the replicate database.

1. Log in to the primary Adaptive Server:
isql -Usa -P -SSAMPLE_PDS
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The isql prompt appears:
>

2. Choose the primary database:
1> use pubs2
2> go

3. Grant the permission on authors table to public:

1> grant all on authors to public
2> go

4. Verify that Chastity Locksley is listed in the au_lname and au_fname columns of the
authors table. To view all author names in the authors table, enter:

1> select au_fname, au_lname
2> from authors
3> go

Adaptive Server prints out the contents of the au_fname and au_lname columns.

5. Change the name of Chastity Locksley to Chastity Hilton in the authors table. Enter:

1> update authors
2> set au_lname = “Hilton”
3> where au_lname = “Locksley”
4> go

6. Verify that the change has taken place at the primary database. For example, enter:
1> select au_fname, au_lname
2> from authors
3> where au_fname = “Chastity”
4> go

The primary Adaptive Server prints out “Chastity Hilton.”
7. Log in to the replicate Adaptive Server:

isql -Usa -P -SSAMPLE_RDS

The isql prompt appears.
8. Choose the replicate database:

1> use pubs2
2> go

9. Verify that the change has replicated to the replicate database:
1> select au_fname, au_lname
2> from authors
3> where au_fname = “Chastity”
4> go

The replicate Adaptive Server prints out “Chastity Hilton,” which indicates that the
replication system is working.

Next
You can create your own Transact-SQL statements to update the primary database and then
view the updates at the replicate database. For example, using the database replication
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definition and database subscription created during configuration, you can perform these
actions and watch the changes appear at the replicate database:

• Add information to a table using the insert command.
• Delete information from a table using the delete command.
• Create and populate a table using the create table and then the insert command.
• Depopulate a table using the truncate table command.

You can create your own database replication definitions that filter out specified tables,
transactions, or data definition language (DDL) commands.

See Replication Server Administration Guide Volume 1 > Manage Replicated Objects Using
Multisite Availability for more information about creating database replication definitions
and subscriptions, and customizing your replication environment.
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Manage Replication Server

Manage Replication Servers and related components in the replication environment.

Starting the Sample Replication Server
Start the sample Replication Server manually if it is shut down. The Replication Server
installer starts the sample Replication Server after you complete the installation.

1. For Windows:

a) Using Windows Explorer, navigate to %SYBASE%\%SYBASE_REP%
\samp_repserver.

b) Double-click RUN_SAMPLE_RS.bat.

2. For UNIX:

a) Navigate to $SYBASE/$SYBASE_REP/samp_repserver.

b) Execute RUN_SAMPLE_RS.

Logging in to the Sample Replication Server
Log in to Replication Server from the command line using the isql utility with the sa user
name.

Use isql to execute Replication Server commands. Logging in to Replication Server is an easy
way to find out if Replication Server is running.

1. From the command prompt, enter:
isql -Usa -Padmin -SSAMPLE_RS

If the sample Replication Server is running, you see:

1>

2. To quit isql, enter:
1> exit

Stopping the Sample Replication Server
Shut down the sample Replication Server.
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1. Log in to the sample Replication Server.

2. Enter:
1> shutdown
2> go

Viewing the Sample Replication Server Logs
View a record of Replication Server actions. Viewing the log can help you identify problems.

Use a text editor to open the SAMPLE_RS.log file.

All log files for the sample Replication Server are located in the samp_repserver
directory. Replication Server records its actions and notes failures in SAMPLE_RS.log.

Viewing Database Replication Definitions
View a database replication definition in Replication Manager for Sybase Central.

1. In the right pane, scroll down to

Replication Environment  > primary_Adaptive_Server_name > primary_dbase_name
> Database replication definitions.

2. In the left pane, double-click a database replication definition. You created the
database_name-1 database replication definition during configuration.
The Replication Definition Properties window opens for the database replication
definition you selected.

Viewing Database Subscriptions
View a database subscription in Replication Manager for Sybase Central.

1. In the right pane, select Replication Environment  > replicate_Adaptive_Server_name >
replicate_dbase_name > Database subscriptions.

2. In the left pane, double-click a database subscription. You created the database_name-1 
database subscription during configuration.
The Subscriptions Properties window opens for the database subscription you selected.

Replication Manager
The Replication Manager (RM) can manage small and simple replication environments by
directly connecting to the servers in the replication environment. It identifies problems within
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the replication environment, and allows you to fix them. It also provides the ability to create,
alter, and delete replication components in the environment.

However, to manage large and complex replication environments with more than ten servers,
the RM requires the help of a monitoring component called Replication Monitoring Services
(RMS). For such environments, the RM provides commands to create, modify, or delete
replication components, while RMS provides the ability to monitor the replication
environment.

For information on monitoring the replication environment using the RM and RMS, see:

• Replication Server Confuguration Guide > Replication Monitoring Services
• Replication Server Administration Guide Volume 1 > Manage Replication Environment

with Sybase Central
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Obtaining Help and Additional Information

Use the Sybase Getting Started CD, Product Documentation site, and online help to learn
more about this product release.

• The Getting Started CD (or download) – contains release bulletins and installation guides
in PDF format, and may contain other documents or updated information.

• Product Documentation at http://sybooks.sybase.com/ – is an online version of Sybase
documentation that you can access using a standard Web browser. You can browse
documents online, or download them as PDFs. In addition to product documentation, the
Web site also has links to EBFs/Maintenance, Technical Documents, Case Management,
Solved Cases, Community Forums/Newsgroups, and other resources.

• Online help in the product, if available.

To read or print PDF documents, you need Adobe Acrobat Reader, which is available as a free
download from the Adobe Web site.

Note: A more recent release bulletin, with critical product or document information added
after the product release, may be available from the Product Documentation Web site.

Technical Support
Get support for Sybase products.

If your organization has purchased a support contract for this product, then one or more of
your colleagues is designated as an authorized support contact. If you have any questions, or if
you need assistance during the installation process, ask a designated person to contact Sybase
Technical Support or the Sybase subsidiary in your area.

Downloading Sybase EBFs and Maintenance Reports
Get EBFs and maintenance reports from the Sybase Web site.

1. Point your Web browser to http://www.sybase.com/support.

2. From the menu bar or the slide-out menu, under Support, choose EBFs/Maintenance.

3. If prompted, enter your MySybase user name and password.

4. (Optional) Select a filter from the Display drop-down list, select a time frame, and click
Go.

5. Select a product.

Padlock icons indicate that you do not have download authorization for certain EBF/
Maintenance releases because you are not registered as an authorized support contact. If
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you have not registered, but have valid information provided by your Sybase
representative or through your support contract, click My Account to add the “Technical
Support Contact” role to your MySybase profile.

6. Click the Info icon to display the EBF/Maintenance report, or click the product description
to download the software.

Sybase Product and Component Certifications
Certification reports verify Sybase product performance on a particular platform.

To find the latest information about certifications:

• For partner product certifications, go to http://www.sybase.com/detail_list?id=9784
• For platform certifications, go to http://certification.sybase.com/ucr/search.do

Creating a MySybase Profile
MySybase is a free service that allows you to create a personalized view of Sybase Web pages.

1. Go to http://www.sybase.com/mysybase.

2. Click Register Now.

Accessibility Features
Accessibility ensures access to electronic information for all users, including those with
disabilities.

Documentation for Sybase products is available in an HTML version that is designed for
accessibility.

Vision impaired users can navigate through the online document with an adaptive technology
such as a screen reader, or view it with a screen enlarger.

Sybase HTML documentation has been tested for compliance with accessibility requirements
of Section 508 of the U.S Rehabilitation Act. Documents that comply with Section 508
generally also meet non-U.S. accessibility guidelines, such as the World Wide Web
Consortium (W3C) guidelines for Web sites.

Note: You may need to configure your accessibility tool for optimal use. Some screen readers
pronounce text based on its case; for example, they pronounce ALL UPPERCASE TEXT as
initials, and MixedCase Text as words. You might find it helpful to configure your tool to
announce syntax conventions. Consult the documentation for your tool.
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For information about how Sybase supports accessibility, see the Sybase Accessibility site: 
http://www.sybase.com/products/accessibility. The site includes links to information about
Section 508 and W3C standards.

You may find additional information about accessibility features in the product
documentation.
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